
CALIBRATION PROCEDURE

NI 5105
This document contains instructions for writing an external calibration 
procedure for National Instruments PXI/PCI-5105 digitizers. This 
calibration procedure is intended for metrology labs. For more information 
about calibration, visit ni.com/calibration.
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Conventions

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box

♦ The ♦ symbol indicates that the following text applies only to a specific 
product, a specific operating system, or a specific software version.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

Bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross-reference, or an introduction 
to a key concept. Italic text also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value 
that you must supply.
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Software Requirements
Calibrating the NI 5105 requires installing the following versions of 
NI-SCOPE on the calibration system.

You can download NI-SCOPE from the Instrument Driver Network at 
ni.com/idnet. NI-SCOPE supports programming the Self-Calibration 
and Verification sections in a number of programming languages; however, 
only LabVIEW and C are supported for the Adjustment section of this 
procedure. 

NI-SCOPE includes all the functions and attributes necessary for 
calibrating the NI 5105. LabVIEW support is installed in 
niScopeCal.llb, and all calibration functions appear in the function 
palette. For LabWindows™/CVI™, the NI-SCOPE function panel 
niScopeCal.fp provides further help on the functions available in CVI. 
Refer to Table 2 for installed file locations.

Calibration functions are LabVIEW VIs or C function calls in the 
NI-SCOPE driver. The C function calls are valid for any compiler capable 
of calling a 32-bit DLL Many of the functions use constants defined in the 
niScopeCal.h file. To use these constants in C, you must include 
niScopeCal.h in your code when you write the calibration procedure.

For more information on the calibration VIs and functions, refer to the 
NI-SCOPE Function Reference Help or the NI-SCOPE LabVIEW 
Reference Help. These references can be found in the NI High-Speed 
Digitizers Help. Refer to the NI-SCOPE Readme for the installed locations 
of these documents.

Table 1.  Required Software for NI 5105 Calibration

Device NI-SCOPE Version

NI PXI-5105 3.1 or later

NI PCI-5105 3.2 or later

Table 2.  Calibration File Locations after Installing NI-SCOPE

File Name and Location Description

IVI\Bin\niscope_32.dll NI-SCOPE driver containing the entire 
NI-SCOPE API, including calibration functions

IVI\Lib\msc\niscope.lib NI-SCOPE library for Microsoft C containing 
the entire NI-SCOPE API, including calibration 
functions
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Documentation Requirements
You may find the following documentation helpful as you write your 
calibration procedure:

• NI High-Speed Digitizers Getting Started Guide

• NI High-Speed Digitizers Help

• NI PXI/PCI-5105 Specifications

• NI-SCOPE LabVIEW Reference Help or NI-SCOPE Function 
Reference Help

These documents are installed with NI-SCOPE. You can also download the 
latest versions from ni.com/manuals.

Password
A password is required to open an external calibration session. If the 
password has not been changed since manufacturing, the password is “NI”.

<LabVIEW>\examples\instr\niScope Directory of LabVIEW NI-SCOPE example 
VIs, including self-calibration.

<LabVIEW>\instr.lib\niScope\
Calibrate\niScopeCal.llb

LabVIEW VI library containing VIs for calling 
the NI-SCOPE calibration API.

IVI\Drivers\niScope\niScopeCal.fp CVI function panel file that includes external 
calibration function prototypes and help on 
using NI-SCOPE in the CVI environment.

IVI\Include\niScopeCal.h Calibration header file, which you must include 
in any C program accessing calibration 
functions. This file automatically includes 
niScope.h, which defines the rest of the 
NI-SCOPE interface. 

IVI\Drivers\niScope\Examples Directory of NI-SCOPE examples for CVI, C, 
Visual C++, and Visual Basic.

Table 2.  Calibration File Locations after Installing NI-SCOPE (Continued)

File Name and Location Description
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Calibration Interval

External Calibration
The external calibration interval for the NI 5105 is two years; however, 
the measurement accuracy requirements of your application determine 
how often you should perform external calibration. You can shorten this 
interval based on your application. Refer to Appendix A: Calibration 
Options for more information.

Self-Calibration
Self-calibration can be performed whenever necessary to compensate for 
environmental changes.

Caution Although you can use self-calibration repeatedly, self-calibrating the NI 5105 
more than a few times a day may cause excessive wear on the relays over time. 

Test Equipment
Table 3 lists the equipment required for externally calibrating the NI 5105. 
If you do not have the recommended instruments, use these specifications 
to select a substitute calibration standard.

Note The delay times indicated in this procedure apply specifically to the Fluke 9500B 
calibrator. If you use a different calibrator, you may need to adjust these delay times.

Table 3.  Required Equipment Specifications for NI 5105 External Calibration

Required 
Equipment

Recommended 
Equipment Parameter Measured Specification

Signal Generator Fluke 9500B 
Oscilloscope 
Calibrator

or

Wavetek 9500 (with 
high-stability 
reference option)

Fluke 9510 Test 
Head

DC Accuracy DC ±(0.025% + 25 μV) 

into 1 MΩ or 50 Ω

Bandwidth ±2% output amplitude 
flatness for leveled sine 
wave up to 60 MHz 
relative to 50 kHz into 

50 Ω

Timing ±2 ppm frequency 
accuracy

BNC to SMB 
adapter

— — 50 Ω
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Test Conditions
Follow these guidelines to optimize the connections and the environment 
during calibration:

• Always connect the calibrator test head directly to the input SMB of 
the digitizer using the BNC to SMB adapter. Long cables and wires act 
as antennae, picking up extra noise that can affect measurements. 

Note Make sure the calibration test head has mechanical support to prevent unnecessary 
strain on the SMB connector of the digitizer.

• Keep relative humidity between 10 and 90% non-condensing, or 
consult the digitizer hardware specifications for the optimum relative 
humidity.

• Maintain an ambient temperature of 23 ±5 °C.

• Allow a warm-up time of at least 15 minutes after the NI-SCOPE 
driver is loaded. Unless manually disabled, the NI-SCOPE driver 
automatically loads with the operating system and enables the device. 
The warm-up time ensures that the measurement circuitry of the 
NI 5105 is at a stable operating temperature. 

• Plug the PXI chassis or PC and the calibrator into the same power strip 
to avoid ground loops.

• (PXI) Ensure that the PXI chassis fan speed is set to HI, that the fan 
filters are clean, and that the empty slots contain filler panels.

Calibration Procedures
The calibration process includes the following steps:

1. Initial Setup—Install the device and configure it in Measurement & 
Automation Explorer (MAX).

2. Adjust the Digital Clock Manager (DCM)—Complete this mandatory 
adjustment periodically, even if you do not do a complete calibration.

3. Self-Calibration—Adjust the self-calibration constants of the device.

4. Verification—Verify the existing operation of the device. This step 
confirms whether the device is operating within its specified range 
prior to calibration.
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5. Adjustment—Perform an external adjustment of the device that adjusts 
the calibration constants with respect to a known reference. The 
adjustment procedure automatically stores the calibration date on the 
EEPROM to allow traceability.

6. Reverification—Repeat the verification procedure to ensure that the 
device is operating within its specifications after adjustment.

These steps are described in more detail in the following sections.

Note  In some cases, the complete calibration procedure may not be required. Refer to 
Appendix A: Calibration Options for more information. 

Initial Setup
Refer to the NI High-Speed Digitizers Getting Started Guide for 
information about how to install the software and hardware, and how to 
configure the device in MAX.

Adjust the Digital Clock Manager (DCM)
Adjusting the digital clock manager for the NI 5105 is a mandatory step 
that is required in addition to the normal calibration process. 
NI recommends that you complete this procedure at least once every two 
years, regardless of whether you choose to perform a verification or 
complete calibration of the device. Completing this procedure does not 
affect the measurements in offset, gain, timing, or bandwidth verification 
sections described later in this document.

Caution Failing to adjust the DCM at least once every two years can result in invalid 
measurements from the NI 5105.
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Complete the following steps to adjust the digital clock manager (DCM) of 
the NI 5105.

1. Obtain an instrument session handle using the niScope Cal Start VI. 

Note Throughout the procedure, refer to the C/C++ function call parameters for the 
LabVIEW input values.

2. Connect the calibrator test head directly to the PFI 1 input of the 
digitizer. Configure the calibrator to output a sine wave with 3.0 Vpk-pk 
amplitude, 50 Ω load impedance, and the Input Frequency listed in 
Table 4 for the current iteration.

3. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

4. Adjust the digital clock manager (DCM) using the niScope Cal Adjust 
DCM VI.

LabVIEW VI C/C++ Function Call

Call niSCope_CalStart with the 
following parameters:

resourceName: The name of the device 
to calibrate. You can find this name under 
Devices and Interfaces in MAX
password: The password required to 
open an external calibration session. If 
this password has not been changed since 
manufacturing, the password is "NI"

LabVIEW VI C/C++ Function Call

Call niScope_CalAdjustDCM 
with the following parameters:

sessionHandle: The session 
handle from 
niScope_CalStart

channelName: "" (empty string)
stimulusFreq: The input 
frequency in Table 4 for the 
current iteration
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5. Repeat steps 2 through 4 for each iteration listed in Table 4.

6. End the session and save the results using the niScope Cal End VI.

You have finished adjusting the External Clock DCM of the NI 5105.

LabVIEW VI C/C++ Function Call

Call niScope_CalEnd with the following 
parameters:

sessionHandle: The session handle from 
niScope_CalStart

action: NISCOPE_VAL_ACTION_STORE

Table 4.  Input Frequencies for Adjusting NI 5105 External Clock DCM

Iteration Input Frequency (MHz)

1 8

2 15

3 22

4 29

5 36

6 43

7 50

8 55

9 60

10 65
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Self-Calibration
The NI 5105 includes precise internal circuits and references used during 
self-calibration to adjust for time and temperature drift. Always 
self-calibrate the digitizer before you perform Verification. NI-SCOPE 
includes self-calibration example programs for LabVIEW, CVI, and 
Microsoft Visual C. 

You can initiate self-calibration using the following methods:

• MAX

• NI-SCOPE Soft Front Panel (SFP)

• NI-SCOPE

MAX
To initiate self-calibration from MAX, complete the following steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Launch MAX.

3. Select My System»Devices and Interfaces»NI-DAQmx Devices.

4. Select the device that you want to calibrate.

5. Initiate self-calibration using one of the following methods:

• Click Self-Calibrate in the upper right corner of MAX.

• Right-click the name of the device in the MAX configuration tree 
and select Self-Calibrate from the drop-down menu.

NI-SCOPE Soft Front Panel
To initiate self-calibration from the NI-SCOPE SFP, complete the 
following steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Launch the Scope SFP, which is available at Start»All Programs»
National Instruments»NI-SCOPE»NI-SCOPE Soft Front Panel.

3. Select the device you want to calibrate using the Device Configuration 
dialog box by selecting Edit»Device Configuration.

4. Launch the Calibration dialog box by selecting Utility»Self 
Calibration.

5. Click OK to begin self-calibration.
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NI-SCOPE
To self-calibrate the NI 5105 programmatically using NI-SCOPE, 
complete the following steps:

1. Disconnect or disable any AC inputs to the digitizer.

2. Open a session and obtain a session handle using the niScope 
Initialize VI.

Note Throughout the procedure, refer to the C/C++ function call parameters for the 
LabVIEW input values.

3. Self-calibrate the digitizer using niScope Cal Self Calibrate VI.
. 

Note Because the session is a standard session rather than an external calibration session, 
the new calibration constants are immediately stored in the EEPROM. Therefore, you can 
include this procedure in any application that uses the digitizer. 

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Note: Wiring the Channel Name and Option inputs is not required for this step.

Call niScope_CalSelf
Calibrate with the following 
parameters:

vi: The instrument handle from 
niScope_init

channelList: VI_NULL
option: VI_NULL
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4. End the session using the niScope Close VI.

Verification

Note After the 15 minute warm-up period, always self-calibrate the NI 5105 before 
beginning a verification procedure. 

This section describes the program you must write to verify either the 
calibration test limits or the published specifications for the NI 5105. Refer 
to Appendix A: Calibration Options to determine which limits to use in 
these procedures.

Note If any of these tests fail immediately after you perform an external adjustment, make 
sure that you have met the requirements listed in the Test Equipment and Test Conditions 
sections before you return the digitizer to National Instruments for repair.

Vertical Offset Accuracy
Table 5 contains the input parameters for verifying vertical offset accuracy, 
the calibration test limits, and the published specifications of the NI 5105. 

To verify vertical offset accuracy, complete the procedures described in this 
section for each of the 18 iterations listed in Table 5 for channel 0, then 
repeat the procedure for each of the remaining 7 channels on the NI 5105.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

Note Throughout the procedure, refer to the C/C++ function call parameters for the 
LabVIEW input values.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameters:

vi: The instrument handle from 
niScope_init
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2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI. 

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested.
inputImpedance: The Input 
Impedance value listed in Table 5 
for the current iteration
maxInputFrequency: The Max 
Input Frequency value listed in 
Table 5 for the current iteration
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI. 

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
range: The Range value listed in 
Table 5 for the current iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 100,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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6. Short-circuit the channel input of the digitizer by connecting the 
calibrator test head directly to the digitizer and grounding the output of 
the calibrator. 

7. Wait 500 ms for the calibrator to ground its output.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement Poly VI. Select 
the Measurement Scalar DBL instance of the VI.

Compare the resulting average voltage to the value listed in the 
Calibration Test Limits column or the Published Specifications 
column in Table 5 that corresponds to the settings used. If the result is 
within the selected test limit, the device has passed this portion of the 
verification.

10. Repeat steps 2 through 9 for each iteration listed in Table 5.

11. Move the calibrator test head to the next digitizer input channel.

12. Repeat steps 2 through 11 for each of the remaining channels, 
updating the channelList parameter with the appropriate channel 
number.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE

_AVERAGE
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13. End the session using the niScope Close VI.

You have finished verifying the vertical offset accuracy of the NI 5105.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameters:

vi: The instrument handle from 
niScope_init

Table 5.  NI 5105 Vertical Offset Accuracy Limits 

Iteration

Max Input 
Frequency 

(MHz) Range (V)

Input 
Impedance 

(Ohms)

Calibration Test Limits (V) Published Specification (V)

PXI-5105 PCI-5105 PXI-5105 PCI-5105

1 60 0.05 50 ±0.0007 ±0.0015 ±0.000725 ±0.001525

2 60 0.20 50 ±0.001 ±0.0018 ±0.0011 ±0.0019

3 60 1.00 50 ±0.0026 ±0.0034 ±0.0031 ±0.0039

4 60 6.00 50 ±0.0126 ±0.0134 ±0.0156 ±0.0164

5 60 0.05 1,000,000 ±0.0007 ±0.0015 ±0.000725 ±0.001525

6 60 0.20 1,000,000 ±0.001 ±0.0018 ±0.0011 ±0.0019

7 60 1.00 1,000,000 ±0.0026 ±0.0034 ±0.0031 ±0.0039

8 60 6.00 1,000,000 ±0.0126 ±0.0134 ±0.0156 ±0.0164

9 60 30.00 1,000,000 ±0.0606 ±0.0614 ±0.0756 ±0.0764

10 60 0.05 50 ±0.0007 ±0.0015 ±0.000725 ±0.001525

11 24 0.20 50 ±0.001 ±0.0018 ±0.0011 ±0.0019

12 24 1.00 50 ±0.0026 ±0.0034 ±0.0031 ±0.0039

13 24 6.00 50 ±0.0126 ±0.0134 ±0.0156 ±0.0164

14 24 0.05 1,000,000 ±0.0007 ±0.0015 ±0.000725 ±0.001525

15 24 0.20 1,000,000 ±0.001 ±0.0018 ±0.0011 ±0.0019

16 24 1.00 1,000,000 ±0.0026 ±0.0034 ±0.0031 ±0.0039

17 24 6.00 1,000,000 ±0.0126 ±0.0134 ±0.0156 ±0.0164

18 24 30.00 1,000,000 ±0.0606 ±0.0614 ±0.0756 ±0.0764
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Vertical Gain Accuracy
Table 6 contains the input parameters for verifying vertical gain accuracy, 
the calibration test limits, and the published specifications of the NI 5105. 

To verify vertical gain accuracy, complete the procedures described in this 
section for each of the 12 iterations listed in Table 6 for channel 0, then 
repeat for each of the remaining 7 channels on the NI 5105.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:

channelList: The name of the 
channel being tested
inputImpedance: The Input 
Impedance value listed in Table 6 
for the current iteration
maxInputFrequency: The Max 
Input Frequency value listed in 
Table 6 for the current iteration
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3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

LabVIEW VI C/C++ Function Call

Call 
niScope_ConfigureVertical 
with the following parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
range: The Range value listed in 
Table 6 for the current iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 100,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init
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6. Connect the calibrator test head directly to the channel input of the 
digitizer and output the Positive Input voltage listed in Table 6 for the 
current iteration. Configure the load impedance of the calibrator to 
match the input impedance of the digitizer.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

9. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement Poly VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Positive Voltage, which is used in step 14.

10. Using the calibrator, output the Negative Input voltage for the current 
iteration listed in Table 6.

11. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
scalarMeasFunction: NISCOPE_
VAL_VOLTAGE_AVERAGE
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12. Initiate a waveform acquisition using the niScope Initiated Acquisition 
VI.

13. Fetch a waveform from the digitizer and perform a voltage average 
measurement using the niScope Fetch Measurement Poly VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured Negative Voltage used in step 14.

14. Calculate the error in the vertical gain as a percentage of input using 
the following formula:

where

a = the Measured Positive Voltage

b = the Measured Negative Voltage

c = the applied Positive Input Voltage

d = the applied Negative Input Voltage

Compare the resulting percent error to the Calibration Test Limits or 
the Published Specifications listed in Table 6. If the result is within the 
selected test limit, the device has passed this portion of the verification.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
scalarMeasFunction: NISCOPE_
VAL_VOLTAGE_AVERAGE

error a b–
c d–
------------⎝ ⎠
⎛ ⎞ 1–⎝ ⎠
⎛ ⎞ 100×=
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15. Repeat steps 2 through 14 for each iteration listed in Table 6.

16. Move the calibrator test head to the next digitizer input channel and 
repeat steps 2 through 15 for each of the remaining channels, updating 
the channelList parameter with the appropriate channel number.

17. End the session using the niScope Close VI.

You have finished verifying the vertical gain accuracy of the NI 5105.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameter:

vi: The instrument handle from 
niScope_init

Table 6.  NI 5105 Vertical Gain Accuracy Stimuli, Calibration Test Limits, and Published Specifications

Iteration

Max Input 
Frequency 

(MHz)
Range 

(V)

Input 
Impedance 

(ohms)
Positive 

Input (V)
Negative 
Input (V)

Calibration 
Test Limits 

(V)

Published 
Specification 

(V)

1 60 0.05 1,000,000 0.0225 –0.0225 ±0.75% ±1.00%

2 60 0.20 1,000,000 0.09 –0.09 ±0.40% ±0.65%

3 60 1.00 1,000,000 0.45 –0.45 ±0.40% ±0.65%

4 60 6.00 1,000,000 2.7 –2.7 ±0.40% ±0.65%

5 60 30.00 1,000,000 13.5 –13.5 ±0.50% ±0.75%

6 60 1.00 50 0.45 –0.45 ±0.75% ±1.00%

7 24 0.05 1,000,000 0.0225 –0.0225 ±0.75% ±1.00%

8 24 0.20 1,000,000 0.09 –0.09 ±0.40% ±0.65%

9 24 1.00 1,000,000 0.45 –0.45 ±0.40% ±0.65%

10 24 6.00 1,000,000 2.7 –2.7 ±0.40% ±0.65%

11 24 30.00 1,000,000 13.5 –13.5 ±0.50% ±0.75%

12 24 1.00 50 0.45 –0.45 ±0.75% ±1.00%
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Timing Accuracy
Complete the following steps to verify the timing accuracy for the NI 5105:

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the 
following parameters:.

channelList: "0"
inputImpedance: 
NISCOPE_VAL_50_OHM

maxInputFrequency: 20,000,000

LabVIEW VI C/C++ Function Call

Call niScope_Configure
Vertical with the following 
parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: "0"
range: 6.0
offset: 0.0
enabled: NISCOPE_VAL_TRUE
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4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

6. Connect the scope calibrator test head directly to channel 0 input of the 
digitizer. Configure the calibrator to output an exact 5 MHz sine wave 
with 1 Vpk-pk amplitude and 50 Ω load impedance.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 60,000,000 
refPosition: 50.0
minNumPts: 1,000,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the 
following parameter:

vi: The instrument handle from 
niScope_init
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9. Retrieve a waveform using the niScope Fetch (poly) VI. Select the 
WDT instance of the VI. Use the default value for the timestamp Type 
parameter.

10. Measure the exact frequency of the peak around 5 MHz using the 
Extract Single Tone Information VI with the following inputs.

• advanced search»approx freq.: –1

• advanced search»search: 5

• export signals: 0 (none)

11. Calculate the error in timing as parts per million (ppm) using the 
following formula:

error = (a – 5,000,000) / 5

where a is the measured frequency.

Compare the result to the Calibration Test Limits column or the 
Published Specifications column listed in Table 7. If the result is 
within the selected test limit, the device has passed this portion of the 
verification.

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 5.0
vi: The instrument handle from 
niScope_init

channelList: "0"
numSamples: –1

LabVIEW VI C/C++ Function Call

Perform an FFT on the array of 
data from step 9.
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12. End the session using the niScope Close VI.

Note The same time source is used for all channels, so you only need to verify the timing 
accuracy on one channel.

You have finished verifying the timing accuracy of the NI 5105.

Bandwidth
Table 8 contains the input parameters for verifying the bandwidth and the 
published specifications of the NI 5105. 

To verify bandwidth, complete the procedures described in this section for 
each of the 6 iterations listed in Table 8 for channel 0, then repeat for each 
of the remaining 7 channels on the NI 5105.

1. Open a session and obtain a session handle using the niScope 
Initialize VI.

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameters:

vi: The instrument handle from 
niScope_init

Table 7.  NI 5105 Timing Accuracy

Calibration Test Limits Published Specifications

±5.3 ppm  ±25 ppm

LabVIEW VI C/C++ Function Call

Call niScope_init with the following 
parameters:

resourceName: The device name 
assigned by MAX
idQuery: VI_FALSE
resetDevice:  VI_TRUE 
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2. Configure the input impedance and the maximum input frequency 
using the niScope Configure Chan Characteristics VI.

3. Configure the common vertical properties using the niScope Configure 
Vertical VI.

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureChan
Characteristics with the following 
parameters:

vi: The instrument handle from
niScope_init 

channelList: The name of the channel 
being tested
inputImpedance: 
NISCOPE_VAL_50_OHM

maxInputFrequency: The Max Input 
Frequency value listed in Table 8 for the 
current iteration

LabVIEW VI C/C++ Function Call

Call niScope_ConfigureVertical 
with the following parameters:

coupling: NISCOPE_VAL_DC
probeAttenuation: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the channel 
being tested
range: The Range value listed in 
Table 8 for the current iteration
offset: 0.0
enabled: NISCOPE_VAL_TRUE



© National Instruments Corporation 27 NI 5105 Calibration Procedure

4. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

5. Commit all the parameter settings to hardware using the niScope 
Commit VI.

6. Connect the calibrator test head directly to the channel input of the 
digitizer. Configure the calibrator to output a 50 kHz sine wave with 
peak-to-peak voltage amplitude set to half the vertical range of the 
digitizer. Configure the load impedance of the calibrator to 50 Ω.

7. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

8. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 10,000,000
refPosition: 50.0
minNumPts: 30,000

LabVIEW VI C/C++ Function Call

Call niScope_Commit with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the following 
parameter:

vi: The instrument handle from 
niScope_init
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9. Fetch a waveform from the digitizer and perform a voltage RMS 
measurement using the niScope Fetch Measurement Poly VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured RMS Voltage of 50 kHz Sine Wave, which is used in 
step 15.

10. Configure the horizontal properties using the niScope Configure 
Horizontal Timing VI.

11. Configure the calibrator to output the Input Frequency listed in Table 8 
for the current iteration.

12. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

LabVIEW VI C/C++ Function Call

Call niScope_FetchMeasurement 
with the following parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_RMS

LabVIEW VI C/C++ Function Call

Call niScope_Configure
HorizontalTiming with the 
following parameters:

enforceRealtime: 
NISCOPE_VAL_TRUE

numRecords: 1
vi: The instrument handle from 
niScope_init

minSampleRate: 60,000,000
refPosition: 50.0
minNumPts: 300,000
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13. Initiate a waveform acquisition using the niScope Initiate 
Acquisition VI.

14. Fetch a waveform from the digitizer and perform a voltage RMS 
measurement using the niScope Fetch Measurement Poly VI. Select 
the Measurement Scalar DBL instance of the VI. This value is the 
Measured RMS Voltage of Generated Sine Wave used in
step 15.

15. Calculate the power difference using the formula:

power = (20log10 a) – (20log10 b)

where 

a is the Measured RMS Voltage of Generated Sine Wave

b is the Measured RMS Voltage of the 50 kHz Sine Wave

If the result is within the test limits in Table 8, the device has passed 
this portion of the verification.

16. Repeat steps 2 through 15 for each iteration listed in Table 8.

17. Move the calibrator test head to the next digitizer input channel and 
repeat steps 2 through 16 for each of the remaining 7 channels. Update 
the channelList parameter to the appropriate channel number each 
time.

LabVIEW VI C/C++ Function Call

Call niScope_Initiate
Acquisition with the 
following parameter:

vi: The instrument handle from 
niScope_init

LabVIEW VI C/C++ Function Call

Call niScope_Fetch
Measurement with the following 
parameters:

timeout: 1.0
vi: The instrument handle from 
niScope_init

channelList: The name of the 
channel being tested
scalarMeasFunction: 
NISCOPE_VAL_VOLTAGE_RMS
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18. End the session using the niScope Close VI.

You have finished verifying the bandwidth of the NI 5105.

Adjustment
If the NI 5105 successfully passed each of the verification procedures 
within the calibration test limits, an adjustment is recommended but not 
required to guarantee the published specifications for the next two years. 
If the digitizer was not within the calibration test limits for each of the 
verification procedures, you can perform the adjustment procedure to 
improve the accuracy of the digitizer. Refer to Appendix A: Calibration 
Options to determine which procedures to perform.

An adjustment is required only once every two years. Completing the 
adjustment procedure automatically updates the calibration date and 
temperature in the EEPROM of the digitizer. 

Note If the digitizer passed the entire verification procedure within the calibration test 
limits and you do not want to perform an adjustment, you can update the calibration date 

LabVIEW VI C/C++ Function Call

Call niScope_close with the following 
parameters:

vi: The instrument handle from 
niScope_init

Table 8.  NI 5105 Bandwidth Limits

Iteration

Max Input 
Frequency 

(MHz) Range (V)
Input 

Frequency (Hz)

Published Specifications

Max (dB) Min (dB)

1 60 0.05 54,900,000 3 –3

2 60 0.20 59,900,000 3 –3

3 60 1.00 59,900,000 3 –3

4 60 6.00 59,900,000 3 –3

5 24 1.00 22,400,000 N/A –3*

6 24 1.00 25,600,000 –3* N/A

* Published specifications value listed for validation of noise filter only. The specification is not included in the device 
specifications document.
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and onboard calibration temperature without making any adjustments by completing only 
steps 1 and 12 in this section. 

Complete all of the following steps to externally adjust the NI 5105.

1. Obtain an instrument session handle using the niScope Cal Start VI.

2. Connect the scope calibrator test head directly to the channel input of 
the digitizer. Configure the calibrator to output the voltage listed under 
the Input (V) column in Table 9. Configure the load impedance of the 
calibrator to 1 MΩ.

3. Wait 2,500 ms for the impedance matching and frequency of the 
calibrator to settle.

4. Adjust the vertical range using the niScope Cal Adjust Range VI.

LabVIEW VI C/C++ Function Call

Call niScope_CalStart with the 
following parameters:

resourceName: The name of the 
device to calibrate. You can find this 
name under Devices and Interfaces in 
MAX
password: The password required to 
open an external calibration session. 
If this password has not been changed 
since manufacturing, the password is 
"NI"

LabVIEW VI C/C++ Function Call

Call niScope_CalAdjust
Range with the following 
parameters:

sessionHandle: The session 
handle from niScope_CalStart
channelName: The channel being 
adjusted 
range: The Range value listed in 
Table 9 for the current iteration
stimulus: The Input Voltage value 
listed in Table 9 for the current 
iteration
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5. Repeat steps 2 through 4 for each iteration listed in Table 9.

6. Move the calibrator test head to the next digitizer input channel and 
repeat steps 2 through 5. Update the channelName parameter for each 
channel being adjusted.

7. Connect the calibrator test head directly to the channel 0 input of the 
digitizer. Configure the calibrator to output an exact 0.3 MHz sine 
wave with 1 Vpk-pk amplitude and 50 Ω load impedance.

8. Adjust the sample rate of the digitizer using the niScope Cal Adjust 
VCXO VI.

Note The 3 MHz stimulus is automatically taken from channel 0.

9. Disconnect or disable all inputs to the digitizer.

10. Self-calibrate the digitizer using niScope Cal Self Calibrate VI.
. 

LabVIEW VI C/C++ Function Call

Call niScope_Cal
AdjustVCXO with the 
following parameters:

sessionHandle: The 
session handle from 
niScope_CalStart

stimulusFreq: 
3,000,000

LabVIEW VI C/C++ Function Call

Call niScope_CalSelf
Calibrate with the following 
parameters:

session handle: The instrument 
handle from 
niScope_CalStart

channelList: VI_NULL
option: VI_NULL
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11. End the session and save the results using the niScope Cal End VI.

You have finished adjusting the NI 5105. Repeat the Verification section to 
reverify the performance of the NI 5105 after adjustments.

LabVIEW VI C/C++ Function Call

Call niScope_CalEnd with the following 
parameters:

sessionHandle: The session handle from 
niScope_CalStart

action: NISCOPE_VAL_ACTION_STORE

Table 9.  NI 5105 Input Parameters for External Adjustment

Iteration Range (V) Input (V)

1 0.05 0.02

2 0.20 0.09

3 1.00 0.425

4 6.00 1

5 30.00 2.5

6 0.05 –0.02

7 0.20 –0.09

8 1.00 –0.425

9 6.00 –1

10 30.00 –2.5
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Appendix A: Calibration Options
External calibration involves verification and if necessary, adjustment and 
reverification. Adjustment is the process of measuring and compensating 
for device performance to improve the measurement accuracy. Performing 
an adjustment updates the calibration date, effectively resetting the 
calibration interval. The device is guaranteed to meet or exceed its 
published specifications for the duration of the calibration interval. 
Verification is the process of testing the device to ensure that the 
measurement accuracy is within certain specifications. Verification can 
be used to ensure that the adjustment process was successful or to 
determine if the adjustment process needs to be performed at all. During 
verification, you must compare the measurement error to the limits given 
in each section.

This document provides two sets of test limits for most verification 
stages—the calibration test limits and the published specifications. 
The calibration test limits are more restrictive than the published 
specifications. If all of the measurement errors determined during 
verification fall within the calibration test limits, the device is guaranteed 
to meet or exceed its published specifications for a full calibration interval 
(two years). For this reason, you must verify against the calibration test 
limits when performing verification after adjustment. If all of the 
measurement errors determined during verification fall within the 
published specifications, but not within the calibration test limits, the 
device is meeting its published specifications. While the device does not 
necessarily remain within these specifications for an additional two years, 
it will meet published specifications for the remainder of the current 
calibration interval. In this case, you can perform an adjustment if you want 
to further improve the measurement accuracy or reset the calibration 
interval. If some measurement errors determined during verification do not 
fall within the published specifications, you must perform an adjustment to 
restore the device operation to its published specifications.

The Complete Calibration section describes the recommended calibration 
procedure. The Optional Calibration section describes alternative 
procedures that allow you to skip adjustment if the device already meets its 
calibration test limits or published specifications.
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Complete Calibration
Perform a complete calibration to guarantee that the NI 5105 meets or 
exceeds its published specifications for a two-year calibration interval. 
At the end of the complete calibration procedure, verify that the 
measurement error falls within the calibration test limits. Figure 1 shows 
the programming flow for a complete calibration.

Figure 1.  Complete Calibration Programming Flow
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Optional Calibration
You can choose to skip the adjustment steps of the calibration procedure if 
the measurement error is within the calibration test limits or the published 
specifications during the first verification. If all of the measurement errors 
determined during the first verification fall within the calibration test 
limits, the device is guaranteed to meet or exceed its published 
specifications for a full calibration interval. In this case, you can update the 
calibration date, effectively resetting the calibration interval, without 
actually performing an adjustment. Refer to the Adjustment section for 
more information. 

If all of the measurement errors determined during the first verification fall 
within the published specifications, but not within the calibration test 
limits, adjustment is also optional. However, you cannot update the 
calibration date because the device will not necessarily operate within the 
published specifications for an additional two years.

Note Regardless of the results of the first verification, if you choose to perform an 
adjustment, you must verify that the measurement error falls within the calibration test 
limits at the end of the calibration procedure. 
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Figure 2 shows the programming flow for the optional calibration.

Figure 2.  Optional Calibration Programming Flow
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Appendix B: Calibration Utilities
NI-SCOPE supports several calibration utilities you can use to retrieve 
information about adjustments performed on the NI 5105, change the 
external calibration password, and store small amounts of information in 
the onboard EEPROM. Although you can retrieve some data using MAX, 
you can retrieve all the data programmatically using NI-SCOPE functions.

MAX
To retrieve data using MAX, complete the following steps:

1. Select the device from which you want to retrieve information from 
My System»Devices and Interfaces»NI-DAQmx Devices.

2. Select the Calibration tab in the lower right corner.

You should see information about the last date and temperature for both 
external and self-calibration.

NI-SCOPE
NI-SCOPE provides a full complement of calibration utility functions 
and VIs. Refer to the NI High-Speed Digitizers Help for the complete 
function reference and VI reference. The utility functions include:

• niScope Cal Change Password VI (niScope_CalChangePassword)

• niScope Cal Fetch Count VI (niScope_CalFetchCount)

• niScope Cal Fetch Date VI (niScope_CalFetchDate)

• niScope Cal Fetch Misc Info VI (niScope_CalFetchMiscInfo)

• niScope Cal Fetch Temperature VI 
(niScope_CalFetchTemperature)

• niScope Cal Store Misc Info VI (niScope_CalStoreMiscInfo)
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Where to Go for Support
The National Instruments Web site is your complete resource for technical 
support. At ni.com/support you have access to everything from 
troubleshooting and application development self-help resources to email 
and phone assistance from NI Application Engineers.

A Declaration of Conformity (DoC) is our claim of compliance with the 
Council of the European Communities using the manufacturer’s 
declaration of conformity. This system affords the user protection for 
electronic compatibility (EMC) and product safety. You can obtain the 
DoC for your product by visiting ni.com/certification. If your 
product supports calibration, you can obtain the calibration certificate for 
your product at ni.com/calibration.

National Instruments corporate headquarters is located at 
11500 North Mopac Expressway, Austin, Texas, 78759-3504. 
National Instruments also has offices located around the world to help 
address your support needs. For telephone support in the United States, 
create your service request at ni.com/support and follow the calling 
instructions or dial 512 795 8248. For telephone support outside the United 
States, contact your local branch office: 

Australia 1800 300 800, Austria 43 662 457990-0, 
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, 
Canada 800 433 3488, China 86 21 5050 9800, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 358 (0) 9 725 72511, France 01 57 66 24 24, 
Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737, 
Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400, 
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, 
Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, 
Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851, 
Singapore 1800 226 5886, Slovenia 386 3 425 42 00, 
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, 
Taiwan 886 02 2377 2222, Thailand 662 278 6777, 
Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545
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